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General Questions

1.  What is a log file?

A log file is a list that is kept by your Web server which details all the files it was 
requested to send and whether it was able to send them successfully. When a visitor clicks 
a link to your Web site, the visitor’s browser sends a request to your Web server and your 
Web server sends the page back to the visitor’s browser. Since a single HTML page can 
include many graphics and other associated files, a single page view can result in several 
entries in the log file.

NetTracker uses the information in the log file to analyze your Web site traffic.

2.  Where are my log files?

Your Web administrator or hosting company should be able to tell you where your log files 
are located. You will need to enter this information in NetTracker when you set up a new 
profile.

3.  What is the difference between the terms Visits, Visitors, and Views?

A view is a hit to a Web page. By default, NetTracker doesn’t count hits to graphics files 
(such as JPGs and GIFs) as page views. You can customize the files you don’t want to 
count as views.

A visit is a series of consecutive views of a Web site by the same user. If the user does not 
view a new Web page in a specified period of time (the default is 30 minutes), the next 
page viewed by that user is considered the start of a new visit.

A visitor is a person viewing a Web site. If your Web site does not use cookies or if the 
visitor does not have a cookie, a visitor is defined as a unique combination of a user agent 
and a host name or IP address. If your site uses cookies sent by the Sane Web Server 
Plug-in, a visitor would be defined by the cookie transmitted by the visitor’s browser. 
NetTracker can also be configured to define visitors based on their HTTP authenticated 
user name or a parsed parameter.

4.  What is the difference between the terms Referrer and Initial Referrer?

In general, a referrer is a Web page that directs visitors to another Web page. Examples of 
referring pages are a search engine like Yahoo and a Web page that has a link to another 
page on the same site.

On the Referrer Summary in NetTracker, a referrer is the Web site that directed a visitor to 
the first page he or she saw on your Web site during the current visit. If a visitor typed the 
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URL of your Web site directly into the browser or used a bookmark to your site, the 
referrer will be None. A single visitor could have a different referrer for each visit, if he or 
she arrived at your site in a different way each time.

An initial referrer is the Web site that directed a visitor to your site the very first time he or 
she visited your site. For example, suppose a visitor originally found your site on Yahoo 
and bookmarked your home page. For that first visit, Yahoo would be both the referrer and 
the initial referrer. If the visitor used the bookmark to visit the site again, the referrer for 
the second visit would be None, but Yahoo would still be the initial referrer. A visitor can 
only have one initial referrer. The initial referrer stays the same from visit to visit.

5.  What does a referrer of None mean?

There are several reasons the referrer would be listed as None:

• You are not logging referrer information in your log file. (If all your referrers 
show up as None, this is probably the reason.) If you tell your server to log that 
field, you will start to see referrer information. For more information on 
configuring your server to log referrer information, please see question 34 though 
question 37.

• The visitor typed the URL of your Web site directly into the browser or used a 
bookmark to your site.

• The visitor’s Web browser may not be passing referrer information to your Web 
server.

6.  Why does NetTracker report a different number of visitors to my Web site 
than other Web site traffic analysis products?

It is highly unlikely that any two products will report an identical number of visitors to a 
Web site. Here’s one reason why:

Robots and spiders (search engine agents) regularly visit Web sites in order to index these 
Web sites in their search engines and directories. Since robots and spiders are not living 
human beings, you probably don’t want them to be counted as visitors to your Web site.

NetTracker automatically filters out many robots and spiders from your list of visitors. 
Chances are that no two products use the exact same list of robots and spiders, so no two 
products will report exactly the same number of visitors.

NetTracker has one of the most extensive lists of robots and spiders and allows you to 
quickly and easily filter out new robots and spiders as they come into existence. Because 
of this, NetTracker frequently reports a lower number of visitors to a Web site than a 
competing product, but our visitors are actual human beings—the ones who purchase 
products and services online.
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Some of the other variables that can affect the number of visitors are the length of time 
between visits, the number of excluded pages, and how hosts are grouped. If these 
variables are not the same in both analysis products, the products will report different 
results.

7.  Can NetTracker analyze content delivered to users by client-side 
technologies like Macromedia Flash and other browser plug-ins?

If the plug-in passes information to the Web server in a form that is logged in the Web 
server’s log file, NetTracker should be able to analyze it. Two methods for analyzing 
content delivered by browser plug-ins are tracking parameters and tracking page requests.

You can set up Macromedia Flash to pass information to the Web server via parameters in 
the query string. (See http://www.macromedia.com/resources/richmedia/tracking/ for 
details.) Because the query string is written to the log file, you can configure NetTracker 
to report on those parameters. You can then use the parameter values as filters in custom 
reports and visitor profiles to provide a more complete view of your users’ behavior. (See 
http://www.sane.com/products/NetTracker/parameter.pdf for details on configuring 
NetTracker to report on parameters. See 
http://www.sane.com/products/NetTracker/power.pdf for details on filtering custom 
reports.)

Another way to track users’ behavior in the plug-in is to analyze which pages the plug-in 
requests from the server. For example, if the browser plug-in requests specific groups of 
pages depending on the users’ behavior, you can create content groups, visitor profiles, 
and custom reports to analyze how often these pages are delivered.

8.  Why doesn’t my Unique Visitors count equal the total number of New 
Visitors plus the total number of Repeat Visitors?

The Unique Visitors count is a count of the number of visitors to the site during the 
specified time period. For example, for January 2003 this number would be all of the 
visitors that visited during January 2003.

The New Visitors count is the number of visitors who made their first visit ever to your 
site during the specified time period. (These are visitors NetTracker doesn't recognize 
from previous visits.) A visitor is only ever new once. For instance, if a visitor came to 
your site for the very first time in January 2003, they would be counted as a new visitor in 
January 2003. If they came to your site once in January 2003 but had previously visited in 
December 2002, they would not show up as a new visitor in January 2003.

The Repeat Visitors count is the number of visitors during the specified time period who 
have been to your site before (visitors NetTracker does recognize). If a visitor comes to 
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your site once in December 2002 and once in January 2003, they will be counted as a 
repeat visitor in January 2003. 

The number of unique visitors will not necessarily equal the number of new visitors plus 
the number of repeat visitors because a visitor can be both a new and repeat visitor in the 
same time period. For example, if a visitor comes to your site for the very first time on 
January 1 and then visits again on January 5, the visitor would be counted as both a new 
and a repeat visitor.

Installing, Maintaining, and Moving NetTracker

9.  Does NetTracker need to be installed on my Web server?

NetTracker Professional and NetTracker Enterprise are designed to be installed on your 
Web server, but they do not have to be. For the NetTracker eBusiness Edition, it is 
recommended that you do not install NetTracker on the same computer as the Web server 
that you are trying to analyze. Instead, you should install NetTracker and the RDBMS on a 
separate, dedicated computer. We recommend that both the NetTracker eBusiness Edition 
and the database be installed on the same computer. This eliminates the network 
connection between the database and NetTracker as a bottleneck.

There does, however, have to be a Web server running on the computer on which you 
install any of the three editions of NetTracker. (The Windows version of NetTracker 
contains a built-in Web server so you can install NetTracker on any computer.) If you 
choose not to install NetTracker on your Web server, you need to make sure that 
NetTracker has access to your log files, either through a local network or through FTP.

10.  My serial number and activation key do not appear to work.

This is usually caused by errors in entering the serial number or activation key. The safest 
way to enter the information is to copy it from the original message.

If you are typing the information, make sure you are typing the activation key exactly as 
given, paying special attention to capitalization. The activation key is case sensitive. Also, 
double-check that you are not confusing the letter l with the number one (1) or vice versa.

Finally, make sure you are downloading the correct version. If you purchased the 
Enterprise version of NetTracker, your serial number and activation key will only key will 
only work with the Enterprise version.
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11.  Where should I install the NetTracker files?

The exact directory paths where you install NetTracker depend on the configuration of 
your Web server. However, the following instructions tell you where to install NetTracker 
files relative to other files on your server.

NetTracker uses three different directories:

• NetTracker HTML directory—Put this directory in its own subdirectory under 
your Web server’s HTML document root. This is where NetTracker stores the 
reports it generates from your log files.

• NetTracker’s CGI-BIN directory—Put this directory in its own subdirectory under 
your Web server’s CGI-BIN document root. On Windows running IIS this would 
usually be under your scripts directory.

• NetTracker program directory—Put this anywhere you want. The default is 
C:\Program Files\NetTracker on Windows and /usr/local/NetTracker on UNIX. 
This directory contains the NetTracker binary and configuration file. In 
NetTracker Professional and NetTracker Enterprise, this directory also contains 
the database files. Depending on the amount of log file data that you are 
processing, the NetTracker database files can get very large. Make sure that you 
have sufficient disk space on this partition to store your NetTracker data.

12.  Is there a limitation on the maximum size of the NetTracker database?

With NetTracker Professional and NetTracker Enterprise, the individual .dat and .idx files 
in the NetTracker/data/profilename directory cannot exceed 2 GB each (due to operating 
system limitations). On Windows NT/2000/XP, Solaris (Sparc/Intel), HP-UX and AIX the 
per file limit is 4 GB. The first file to approach this limit is usually the views.dat file. If 
you are approaching this limit, you should use NetTracker’s Remove or Archive features 
(available in the options for the profile) to remove data from the NetTracker profiles. You 
can avoid this file-size limitation by upgrading to the NetTracker eBusiness Edition, 
which uses an external Oracle or SQL Server database. There is virtually no limit to the 
amount of data that you can analyze with the NetTracker eBusiness Edition.

Note: The 2 or 4 GB size limit applies to each individual data file for a profile, not to the 
total size of the log files. Since the Web site traffic data is spread across multiple data files, 
you can typically import around 14 to 16 GB of log files (depending on density) into a 
single NetTracker profile before reaching the 2 or 4 GB size limitation.

13.  How do I back up NetTracker and the data that I have imported into it? 
What directories do I need to back up and how do I restore the data if I need 
to?

You should back up the following directories:
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• NetTracker database directory and its subdirectories—This directory is called 
data and can be found in the NetTracker program directory. The default UNIX 
location is /usr/local/NetTracker/data. The default Windows location is 
C:\Program Files\NetTracker\data.

• NetTracker CGI-BIN directory and its subdirectories—This directory is in your 
Web server’s CGI-BIN or scripts directory.

• NetTracker HTML directory and its subdirectories—This directory is in your Web 
site’s HTML or wwwroot directory.

• Oracle or SQL Server database (NetTracker eBusiness Edition only)

To restore NetTracker data
1. Re-install NetTracker if necessary.
2. Restore the data directory, replacing the one NetTracker creates during 

installation.
3. Restore the NetTracker CGI-BIN directory.
4. Restore the NetTracker HTML directory.
5. If you are running the NetTracker eBusiness Edition, restore your Oracle or SQL 

Server database.
6. Go to the command line and change to the NetTracker program directory.
7. Run the following command to regenerate appropriate HTML for all the 

NetTracker profiles:
nettracker all -regen

14.  What can I do to improve the performance of the NetTracker eBusiness 
Edition and my Oracle database?

You can download a document with detailed performance-tuning information at 
http://www.sane.com/products/NetTracker/oracletune.pdf. This document will help you 
optimize your Oracle configuration for NetTracker. It was completed after extensive 
testing at the Oracle Applications Solution Center (ASC) in Redwood City, where our 
engineers worked side-by-side with Oracle engineers to optimize NetTracker for use with 
Oracle. Following the suggestions in this document can result in speed improvements as 
high as 400 percent.

15.  Is there any way to make the NetTracker eBusiness Edition run faster?

To run diagnostics on the database to which NetTracker is writing
1. Go to the command line.
2. Change to the NetTracker directory. 
3. Type nettracker shortprofilename -checkdb
4. If -checkdb indicates that indices are missing from your database, type 

nettracker shortprofilename -reindex-missing to restore them. This 
should improve NetTracker performance.
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5. If -checkdb indicates that the statistics are out of date on the tables in your 
database, type nettracker shortprofilename -reanalyze (NetTracker 
eBusiness Edition for Oracle only).

6. If -checkdb indicates other problems with the database, consult with your 
database administrator.

Note: For more information about the -checkdb option, see the Command-Line Options 
section of the NetTracker manual.

It might help to have your database administrator read the NetTracker database schema, 
which is available at http://www.sane.com/support/NetTracker/nt60schema.pdf.

If you are using NetTracker eBusiness Edition for Oracle, you also may need to tune your 
Oracle database. For more information see the Oracle Performance Tuning Guide 
available at http://www.sane.com/products/NetTracker/oracletune.pdf. Following the 
suggestions in this document can result in speed improvements as high as 400 percent.

16.  How do I schedule NetTracker to run every night?

For UNIX servers:

NetTracker comes with a command-line utility, nettracker, which can be used to 
automatically generate profiles each night. The easiest way to configure this option is 
to add this command to your system’s crontab file. For example, to update your 
profiles each night at midnight, simply add the following line to your system’s crontab 
file:

0 0 * * * /path/to/program/directory/nettracker all 
-update -quiet -email -dir 
/path/to/program/directory/

For Windows servers:

NetTracker comes with a command-line utility, NetTracker.exe, which can be used to 
automatically generate profiles each night. The easiest way to configure this option is 
to use the Windows schedule service. If the schedule service is not running on your 
computer, you will have to go to Services in the Control Panel and set it up to start 
automatically. Once the schedule service is running you can use the AT command 
from the MS-DOS command prompt to schedule a job. For example, to update your 
profile each night at 11:05 P.M., use the AT command:

AT 11:05PM /every:m,t,w,th,f,sa,su “c:\Program 
Files\NetTracker\nettracker.exe” all -update -quiet 
-email -dir “c:\Program Files\NetTracker”
7
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17.  How should NetTracker be set up to use Microsoft IIS security?

IIS file permissions are a bit tricky because IIS uses the file permissions of the file system 
and does not have its own permissions. If you connect to the Web server (IIS) 
anonymously, the server should run as the anonymous user set up in the IIS service 
manager. If you log in, any CGI process (NetTracker is a CGI process) is supposed to run 
as the user that you are logged in as. Whatever user you are logged in as (through HTTP 
authentication) needs to have the following permissions:

• C:\InetPub\scripts\NetTracker and all subdirectories (FULL CONTROL)
• C:\InetPub\wwwroot\NetTracker and all subdirectories (FULL CONTROL)
• C:\Program Files\NetTracker and all subdirectories (FULL CONTROL)

For the Enterprise and eBusiness editions, you may also want to restrict access by profile. 
This may be accomplished in the following way. Administrators will need:

• C:\InetPub\scripts\NetTracker and all subdirectories (FULL CONTROL)
• C:\InetPub\wwwroot\NetTracker and all subdirectories (FULL CONTROL)
• C:\Program Files\NetTracker and all subdirectories (FULL CONTROL)

Users will need access only to their profile directory, their data directory, and the 
NetTracker program files:

• C:\InetPub\scripts\NetTracker\shortprofilename (READ)
• C:\InetPub\wwwroot\NetTracker\shortprofilename and all subdirectories (FULL 

CONTROL)
• C:\Program Files\NetTracker (READ)
• C:\Program Files\NetTracker\data (READ)
• C:\Program Files\NetTracker\data\shortprofilename (FULL CONTROL)

18.  I installed Microsoft’s URLScan security tool and now NetTracker has 
stopped working correctly. How can I configure URLScan to allow 
NetTracker to work correctly?

This Microsoft utility by default blocks all files that have an .exe extension from running 
in IIS. NetTracker’s CGI functionality, which includes editing the NetTracker options, 
drilling down, and the administration page in NetTracker Enterprise and the eBusiness 
Edition, requires the ability to run files with .exe extensions.

If you have installed the Microsoft IIS security tool URLScan, you will need to make the 
following changes to the URLScan.ini file. 

This file can be found by default in:
8



C:\WINNT\system32\inetsrv\urlscan\

You will need to comment out .exe from the Deny Extensions group.

When done correctly, it should look like this:

;Executables that run on the server
;.exe
.bat
.cmd
.com

Note: After you save URLScan.ini, you will need to stop and restart the Word Wide Web 
Publishing service in order for these changes to take effect.

For more information about URLScan check out the Microsoft Knowledgebase article 
available at 
http://support.microsoft.com/default.aspx?scid=KB;en-us;q307608.

19.  The data files in my NetTracker data directory or my SQL Server or 
Oracle database have become very large. How can I remove data from the 
NetTracker database to free up some disk space?

You can only remove data from the NetTracker database by month. Once the data has been 
removed you can only get it back by deleting all of the data and reprocessing all of the log 
files.

You can remove data using the browser interface or using the command-line options.

To remove data from the NetTracker database using the browser interface
1. Open the profile from which you want to remove data. (Enterprise and eBusiness 

only)
2. Click the Options tab in the main NetTracker panel.
3. Choose Remove Data From Profile in the NetTracker Options menu.
4. If you want to save the reports for the data you are deleting, select the Archive 

data check box. (When you archive a report you lose the ability to drill down in 
the report. An archived report has no links.)

5. Select the month or months whose data you want to delete and click Remove 
Selected Months. If you want to delete the data from all the months, click 
Remove All Months.

To remove data from the NetTracker database using command-line options
1. Go to the command line (DOS prompt).
2. Change to the NetTracker program directory.
9
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3. Type one of the following commands:
• To remove data for a single month, type
nettracker shortprofilename -remove YYYYMM

• To remove data for multiple months, type
nettracker shortprofilename -remove YYYYMM,YYYYMM

YYYYMM is the four-digit year and two-digit (numeric) month of the month you want to 
remove.

20.  I am setting up NetTracker to run nightly. Can I back up and rotate the 
log files after NetTracker is done processing them? Or, in other words, does 
NetTracker cache the data it gets from the log files or does it have to 
process the log files as a whole each time it runs?

NetTracker imports log data into its own internal database. For subsequent updates, 
NetTracker will remember where it left off in a log file and pick up from there. Once the 
log file data is imported, NetTracker no longer needs access to the log file.

After NetTracker is done processing your logs, you can rotate them out, since NetTracker 
has imported the data into its internal database. We recommend that you back up your log 
data so it is available for use in the future.

21.  I want to move NetTracker to another machine. What is the best way to 
do this?

To move NetTracker to another computer (NetTracker Professional)
1. Install NetTracker on the other computer.
2. If you want to keep your profile configuration, copy reports.cfg from the original 

computer to the new computer. (Reports.cfg is stored in the 
NetTracker/data/reports directory.)

3. Reimport your log data.

To move NetTracker to another computer (NetTracker Enterprise and NetTracker 
eBusiness Edition)

1. Install NetTracker on the other computer.
2. Create a new profile for every old profile. If you want to keep your profile 

configurations, give the new profiles exactly the same names as the old ones.
3. If you want to keep your profile configurations, copy the old profilename.cfg files 

to the new computer. Profilename.cfg files are stored in the 
NetTracker/data/profilename directory, where profilename is the short name of the 
profile (the one that appears in parentheses in the NetTracker Profile Manager).

4. Reimport your log data.
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Note: If you have created custom reports that you want to keep and you did not change 
platforms when you moved to the new computer, just copy your custom *.* files. If you 
did change platforms, first create dummy custom reports for all your old custom reports, 
and then copy your old customXXX.def files over the new ones.

22.  I want to move NetTracker to another machine and I do not want to 
reimport my log file data. How do I do this?

Note: You can only copy the database files between two installations of NetTracker if both 
installations are running on the same platform.

NetTracker Professional
1. Install NetTracker on the new computer.
2. Copy the data directory to the new computer. The data directory is located in the 

NetTracker program directory. (On Windows the default program directory is 
C:\Program Files\NetTracker. On UNIX the default program directory is 
/usr/local/NetTracker.)

3. Run nettracker all -regen (from the NetTracker program directory) on the 
new installation to regenerate the associated HTML files.

NetTracker Enterprise
1. Install NetTracker on the new computer.
2. Create empty profiles with the same names as your old profiles. This is the name 

that appears in parentheses in the list of profiles in the Profile Manager. You do 
not need to set any of the configuration options for these profiles.

3. Copy the data directory to the new computer. The data directory is located in the 
NetTracker program directory. (On Windows the default program directory is 
C:\Program Files\NetTracker. On UNIX the default program directory is 
/usr/local/NetTracker.)

4. Run nettracker all -regen (from the NetTracker program directory) on the 
new installation to regenerate the associated HTML files.

NetTracker eBusiness Edition
1. Install NetTracker on the new computer.
2. Create empty profiles with the same names as your old profiles. This is the name 

that appears in parentheses in the list of profiles in the Profile Manager. You do 
not need to set any of the configuration options for these profiles.

3. Copy the data directory, located under the main NetTracker program directory, 
from the old computer to the new computer. (On Windows the default program 
directory is C:\Program Files\NetTracker. On UNIX the default program directory 
is /usr/local/NetTracker.)

4. Copy all of the NetTracker tables from your old database to the new database. The 
tables specific to NetTracker will be NT_Reports and all tables that follow the 
convention profilename_*. (For example, if you only had one profile and it was 
11
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named reports, the tables you would want to copy over to the new database would 
be: NT_Reports, reports_Sum_Dir, reports_ServerID, reports_Sum_Entry, and so 
on.)

5. Run NetTracker all -regen (from the NetTracker program directory) on the 
new installation to regenerate the associated HTML files.

23.  I am running out of disk space and need to move the NetTracker data 
directory to another drive on the same computer. How do I do this?

You cannot move the data directory by itself, but you can move the entire NetTracker 
program directory to another drive.

To move the NetTracker program directory from one drive to another
1. Make a complete backup of NetTracker. (For details, see question 13.)
2. Find the NetTracker program directory (the directory to which NetTracker was 

installed).
3. In the NetTracker program directory, open NetTracker.cfg in a text editor.
4. Find the line that looks like the following:

<progdir>C:\Program Files\NetTracker\</progdir>
5. Edit the line to show the directory to which you are moving NetTracker.
6. Find the <htmldir> line. If the path contains NTWeb, edit the part of the path 

before NTWeb to show the directory to which you are moving NetTracker.
7. Find the <cgidir> line. If the path contains NTWeb, edit the part of the path before 

NTWeb to show the directory to which you are moving NetTracker.
8. Copy the NetTracker program directory and all of its subdirectories to the location 

you just specified in the <progdir> element.
9. Do one of the following:

• If you are using NetTracker with IIS, complete the following steps.
a Open the registry editor and find the key 

HKEY_Local_Machine\SOFTWARE\Sane Solutions\NetTracker 
<version> <edition>\. 

b The second NetTracker registry entry will be named with the path to your 
NetTracker CGI directory. Modify this entry and change the value of the 
data field to the new path to the NetTracker program directory.

• If you are not using NetTracker with IIS, complete the following steps.
a Find the <cgidir> element in NetTracker.cfg. This tells you the 

NetTracker CGI directory. 
b Go to the NetTracker CGI directory and open a subdirectory.You should 

see the file ntcgi.cfg. 
c Open ntcgi.cfg in a text editor and edit the directory listed in the first line 

of the file so it matches the new NetTracker program directory. 
d Save and close ntcgi.cfg. 
e Repeat step b through step d for each copy of ntcgi.cfg located in a 

subdirectory of the NetTracker CGI directory.
12



10. Save and close NetTracker.cfg.
11. Look in your new NetTracker program directory. If you see the file NTWeb.cfg, 

open it in a text editor. (If the file does not exist, you are finished with the moving 
process. You should be able to use NetTracker in its new location.)

12. Edit the third line of NTWeb.cfg to show the new program directory. Make sure 
the line still ends in NTWeb\, as in the following example:
D:\NetTracker\NTWeb\

13. Save and close NTWeb.cfg.
14. If you edited NTWeb.cfg, you will need to edit the target of the NetTracker 

shortcut to point to the new NetTracker program directory. (In most Windows 
installations, you can right-click the shortcut and click Properties to access the 
Target field.)

24.  We would like to be able to access NetTracker through the Internet, but 
the machine we installed NetTracker on currently uses an internal IP 
address or is behind a firewall. How do we do this?

The first thing to do is to get NetTracker installed on a machine that is accessible from the 
Internet. If you need to move NetTracker to a new machine in order to accomplish this, 
please follow the directions outlined in question 21 and question 22.

If you can reconfigure the machine NetTracker is already installed on so that it has a valid, 
Internet-routable IP, then this would be fine, and you shouldn’t need to re-install 
NetTracker. If the URLs used to access NetTracker change because of this 
reconfiguration, please follow the directions outlined in question 25 for changing the URL 
used to access NetTracker.

25.  How do I change the URLs used to access NetTracker?

To change the URL used to access NetTracker you will need to edit the two URLs 
(<htmlurl> and cgiurl>) in the NetTracker.cfg file located in the main NetTracker program 
directory. After you have saved your changes, you will need to run the following 
command at a command line from within the main NetTracker program directory:

For UNIX servers:

./nettracker all -regen

For Windows NT/2000/XP servers:

nettracker all -regen

If you are using the Enterprise or eBusiness Edition, then you will also need to run the 
command:
13
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For UNIX servers:

./nettracker admin -clear

For Windows NT/2000/XP servers:

nettracker admin -clear

These commands will correct the links in NetTracker’s HTML files so that NetTracker 
will continue to function properly using the new URLs.

26.  Does it matter which database and client-side character sets I use in 
Oracle?

Yes. The database and client-side character sets you use when creating your Oracle 
database can have a significant impact on NetTracker. The WE8ISO8859P1 character set 
is safe to use as both the database and the client-side character set. The US7ASCII set 
should never be used. If you are considering using a character set other than 
WE8ISO8859P1, you should first contact Sane Solutions technical support. If you do not 
know what character set you are using, contact your database administrator.

27.  Does it matter which character sets I use in SQL Server?

Yes. Your database should use a case-sensitive and accent-sensitive character set. The 
character set Latin1_General_BIN is usually a good choice.

Using Log Files

28.  Can I analyze multiple log files in a single profile?

Yes. Just enter multiple log files on the Log Files page in the NetTracker profile options 
and NetTracker will process all of the log files.

29.  Can I use wildcards to specify log files?

Yes. If you use a wildcard in the Log file box, NetTracker will analyze all files in the 
specified directory that match the pattern. For example, if you entered /home/logs/*.log in 
the Log file box, NetTracker would analyze all logs matching the pattern *.log in the 
directory /home/logs.

This feature is particularly useful if your Web server is set up to rotate logs automatically.
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30.  Can NetTracker analyze log files compressed using gzip?

Yes. If you enter a log file with a .gz file extension, NetTracker will automatically read 
from the compressed file. You can also use wildcards to specify files compressed with 
gzip.

31.  I am running Lotus Domino and am trying to analyze log files created by 
the Notes server. The filename is domlog.nsf. NetTracker does not 
recognize this file. What is wrong?

NetTracker can only analyze the text log files generated by a Domino Web server. 
NetTracker can not read directly from .nsf files.

To configure Lotus Domino 4.x to log to a text file
1. In Lotus Notes, open your Address Book.
2. Go to Server/Servers and double-click the server in the window on the right. 
3. Click Edit Server.
4. Under Enable Logging To, select enabled to the right of Log Files in the HTTP 

Server options.
5. Set the Access log format to the Extended Common log format.
6. Set the time format for your logs to the local time.
7. To activate your changes, stop your Domino server and then restart it.
8. Point NetTracker to the new log file.

To configure Lotus Domino 5.x to log to a text file
1. Open Lotus Notes.
2. On the File menu, click Database and then click Open.
3. Change the server to the Domino server you want to configure.
4. Select the server’s address book (names.nsf).
5. Expand the server list on the left of the screen.
6. Select Servers.
7. On the right of your screen, double-click your server.
8. Select Internet Protocol.
9. Under Enable Logging To, change the Log Files option to Enabled.
10. Under Log File Settings, change the Access log format option to Extended 

Common.
11. Under Log File Settings, change the Time Format option to LocalTime.
12. Save and close the screen.
13. To activate your changes, stop your Domino server and then restart it.
14. Point NetTracker at the new log file.
15
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32.  I use load balancing across multiple Web servers on my Web site. Will 
NetTracker analyze the data from these logs accurately?

Yes, NetTracker can analyze logs from multiple clustered or load-balanced Web servers. 
You must specify that you are using clustered log files when you set up the log files for 
NetTracker to process.

To specify that you are using clustered log files
1. Open the NetTracker profile that uses clustered log files. (Enterprise and 

eBusiness only)
2. Click the Options tab.
3. In the left-hand panel, click Log Files under Main.
4. In the Log files are list, select the configuration that matches the log files that you 

want to analyze. There are two possible configurations for multiple servers.
• Clustered for a single site—Multiple Web servers, all of which are serving 

the same content. Hits to the servers are load balanced among the different 
servers so that a request to the Web site can go to any one of the servers. For 
example, if a user requested your home page, any one of the three servers 
could serve the page.

• Clustered for multiple sites—Multiple Web servers which are a part of the 
same domain. Each server serves different content. For example, in the 
yoursite.com domain, the server home.yoursite.com serves the home page and 
general content, and the server catalog.yoursite.com serves the catalog pages. 
(Within each site in the cluster, you can also have multiple load-balanced 
servers. For example, the catalog pages could be served by any of three 
servers clustered as catalog.yoursite.com.)
Note: The servers should usually be part of the same domain. If you need to 
cluster servers from different domains, contact Sane Solutions technical 
support.

5. Click Save Options and then click Continue.
6. Click Server1 and then click Edit.
7. Enter a name and URL for the server.

If the servers are clustered for multiple sites, you must enter a different URL for 
each site. In the example earlier, you would use http://home.yoursite.com for the 
first server and http://catalog.yoursite.com for the second. (Load-balanced servers 
within a site can all use the same URL. For example, all three servers clustered as 
catalog.yoursite.com would use http://catalog.yoursite.com.)

8. Click Save Options and then click Continue.
You must create a server entry for each server in the cluster.

9. Add each additional server by clicking Add.
When you are through adding all of the servers, you need to specify the location 
of each of the servers’ log files.

10. To specify the location of a server’s log files, click the server and click Add/Edit 
Log Files.
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11. Click Add.
12. In the Location of log file(s) list, select an option.

• If your logs are located on the machine that is running NetTracker or are 
available on the local network, select Local/network file system.

• If your logs are available via FTP and you want NetTracker to retrieve them 
for you, select FTP server.

13. In the Format of log file(s) list, select the format of the log file. Select Auto 
Detect to have NetTracker determine your log format automatically. (NetTracker 
can process log files that have been compressed using gzip.) If your log files are in 
a nonstandard format, you will need to first manually specify the log file format. 
(For details, see “Manually Specifying the Log File Format,” in the NetTracker 
manual.

14. Specify the path and filename of the log file.
• If you selected Local/network file system, enter the log file path and filename 

in the Full path to log file(s) box. You may use wildcards. You may also click 
Browse to find the file. (The Browse button will not appear if it has been 
disabled in the administrative options.)

• If you selected FTP server, click Browse and enter the following information 
about the FTP server from which you will be downloading log files.
a Host name: The name of the server (yourdomain.com, not 

ftp://yourdomain.com).
b User name: Your user name for the FTP server. If you access the server 

anonymously, leave this blank.
c Password: Your password for the FTP server. If you access the server 

anonymously, leave this blank.
d Password (again): The same password you entered above.
e Initial path: The directory in which the log file can be found on the 

server. In some cases on a UNIX-based FTP server, this should be the 
complete system path to that directory. If you are accessing a 
Windows-based FTP server, usually the path is relative to the FTP root 
directory.

When you have entered the information about the FTP server, click Browse 
and select the log file.

15. Click Add and then click Continue.
16. Repeat step 11 through step 15 until you have specified all of the log files for this 

server.
17. When you have finished adding log files for one server, click Back to Servers and 

perform step 10 through step 17 for the remaining servers.

Note: It is possible to have Web servers clustered for multiple sites and have multiple 
load-balanced servers for each site in the cluster. If that is the case, follow the instructions 
for servers clustered for multiple sites. However, when you get to step 7, more than one 
server will use each URL.
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Note: If you are analyzing logs from multiple Web servers using either the Clustered 
for multiple sites option or the Clustered for single site option, the logs for each server 
must be rotated at the same time by your Web server and the log files must use the 
same naming scheme.

For example, if you have three load-balanced servers all serving the same content and you 
are rotating the log files daily at midnight, the name of the log files for each day should 
correspond. For instance, you could use the naming scheme yyymmdd.log for all servers. 
On January 1, 2000, the logs for each of the three servers would be named 20000101.log. 
Note that log file names such as Server1.20000101.log, Server2.20000101.log, and 
Server3.20000101.log will not be analyzed correctly by NetTracker because the file names 
are not exactly the same.

33.  I have NetTracker installed on an IIS Web server and NetTracker keeps 
telling me that it cannot find log files on a mapped network driver when 
setting the Log File options. What is wrong?

IIS cannot access files on network drives easily. You can find a discussion of this issue and 
suggested workarounds in the Microsoft Knowledge base at 
http://support.microsoft.com/default.aspx?scid=KB;en-us;q257174.

Because NetTracker is running as a CGI application when searching for log files, it 
inherits this limitation from IIS. To work around this problem, you can do one of two 
things:

• Install an FTP server on the machine where your logs are located and configure 
NetTracker to fetch the logs via FTP.

• Set the Log File option as you normally would to point to the logs on the mapped 
drive, ignoring NetTracker’s error message that it cannot locate the logs. Do not 
update. Then open the command line (DOS prompt). Change to the NetTracker 
program directory (the default is C:\Program Files\NetTracker) and run 
nettracker short_profile_name -update. Because NetTracker is not 
running through IIS, it will be able to import the log files. (If it cannot, make sure 
the user you are logged in as on your Windows machine has read permission to 
the directory where the logs are located on the network.)

34.  How do I log browser and referrer information using Apache?

With Apache, we recommend that you log to NCSA Combined Log Format.

To log to NCSA Combined Log Format in Apache 1.3 or Apache 2.0
1. Open httpd.conf in a text editor. (In Windows, the default location for httpd.conf 

is C:\Program Files\Apache Group\Apache\conf.)
2. Find the LogFormat line
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LogFormat "%h %l %u %t \"%r\"  %>s %b \"%{Referer}i\" 
\"%{User-Agent}i\"" combined

If you can’t find it, add it.
3. Comment out the lines

CustomLog logs/access_log common
CustomLog logs/referer_log referer
CustomLog logs/agent_log agent

4. Uncomment the line
CustomLog logs/access_log combined

5. Save and close httpd.conf.
6. Restart Apache. 

35.  How do I log browser and referrer information using Netscape 
FastTrack, Enterprise, or iPlanet servers?

To log browser and referrer information using a Netscape/iPlanet server
1. Log to Netscape Flexible Log Format.
2. Set the Log client accesses? option to Yes.
3. Set the Record option to Domain Names.
4. Under Format, for the Only log option, turn on at least the following fields:

• Client hostname
• Authenticated user name
• System date
• Full request
• Status
• Content length
• HTTP header, "referer"
• HTTP header, "user-agent"

36.  How do I log browser and referrer information using Microsoft IIS 4.0 or 
5.x?

To log browser and referrer information in Microsoft IIS 4.0 or 5.x
1. Open the Internet Services Manager (sometimes called the management console).
2. Expand the Internet Information Services tree until you can see the Web site 

whose logging you want to configure.
3. Right-click the Web site and click Properties.
4. Click the Web Site tab and make sure that the Enable Logging check box is 

selected. In the Active log format box, select W3C Extended Log File Format.
5. Click Properties.
6. Click the Extended Properties tab.
7. Select the User Agent field (for browser and platform information) and the 

Referer field.
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37.  How do I log browser and referrer information in a Web server not listed 
above?

To log browser and referrer information in a Web server not listed above, you will need to 
configure your server to log to an extended format that NetTracker can understand. Most 
Web servers provide a way to log to NCSA Combined log format. You can find the 
specifications for the NCSA Combined log format at 
http://hoohoo.ncsa.uiuc.edu/docs/setup/httpd/TransferLog.html.

38.  I want to use cookies to better track my Web site visitors. Are there any 
plug-ins available for NetTracker to help me do this?

NetTracker comes with Web server plug-ins that can be installed on your Web server and 
used to automatically generate persistent cookies that will allow you to track visitors as 
they traverse your Web site. Using cookies allows you to better track new, unique, and 
repeat visitors. In addition, the cookies allow you to better separate multiple users 
accessing your site from behind a proxy server or firewall. One key benefit of the plug-in 
approach is that you do not need to make any modifications to your site’s Web pages.

There are three plug-ins available. Which one you need depends on the Web server you are 
using. There is an NSAPI plug-in for Netscape/iPlanet Web servers, an ISAPI plug-in for 
Microsoft Internet Information Server and a source code module for Apache Web servers. 
The plug-ins are available for downloading from the NetTracker utilities page at 
http://www.sane.com/download. The readme file included with the plug-in contains 
detailed instructions on installing it.

The server plug-ins also enable NetTracker to gather extended data on server performance 
and aborted requests. On Microsoft Internet Information Server, the plug-in can also be 
used to do DNS lookups. This allows you to translate the IP address of the host computer 
accessing your Web site to the hostname and domain as it is written to the log file.

39.  How can I track visitors’ screen resolution information?

Tracking visitors’ screen resolution information is a three-step process:

• Acquire the information through the browser
• Get the screen resolution information into the Web server log files
• Configure NetTracker to report on that information

Gathering the Information through the Browser

Retrieving client-side display properties can be done through the use of the JavaScript 
screen object. The JavaScript screen object is available with JavaScript 1.2 and later.
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The screen object contains the following five properties:

Note: In most situations, colorDepth will be equal to the bits-per-pixel used by the display. 
However, a browser may limit itself to a subset of the available colors. In these situations, 
the value of the colorDepth property is a number less than the bits-per-pixel value of the 
display.

Logging the Information

In order for NetTracker to be able to track screen resolution data, the data must be placed 
in the log files. Here is a quick example that uses JavaScript to pass information from the 
screen object properties above as part of an image request.

<script language="JavaScript1.2">
     var sPage = ’/image.gif?’;
     sPage = sPage + ’screenRes=’ + screen.width = ’s’ 
+ screen.height;
     sPage = sPage + ’&availRes=’ + screen.availWidth 
+ ’x’ + screen.availHeight;
     sPage = sPage + ’&colorDepth=’ + 
screen.colorDepth;

     document.write( ’<img src="’ + sPage + ’">’ );
</script>

In the Web server log file, this should generate a request similar to:

/image.gif?screenRes=1280x1024&availRes=1280x996&colorDepth=32

Property Description

width Width of the display in pixels

height Height of the display in pixels

availWidth Width of display area available for use. (Value of width minus width used 
for features such as the Windows taskbar.)

availHeight Height of display area available for use. (Value of height minus height 
used for features such as the Windows taskbar.)

colorDepth Base-2 logarithm of the number of colors that can be displayed. 
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Configuring NetTracker

Now you need to configure NetTracker to track the parameters that store the screen 
resolution information. In our example, these are query string parameters.

To track a parameter in a query string 
1. View the profile in which you want to track the screen resolution information.
2. Click the Options tab.
3. In the left-hand panel, click Parameters under Dynamic Content.
4. Click Add.
5. In the Name box, enter the name that you want to use for this parameter in the 

Parameter Summary. Use only alphanumeric characters. Do not use any spaces. 
This name is limited to a maximum of 10 characters. (In the example used earlier, 
if you wanted to track the screenres parameter, you could use the name 
Resolution.)

6. In the Parameter box, enter the parameter you want to track. (In the example 
earlier, you would enter screenres.)

7. Leave the Parameter lookup URL box empty.
8. In the Type of parameter list, select Query String.
9. Select the Create custom report check box to have NetTracker automatically 

create a Parameter Summary for this parameter the next time the profile is 
updated. The summary will be listed under Custom Analysis on the Reports tab.

10. Click Save Options and then click Continue.
11. Select the parameter and click Pages.
12. Click Add.
13. Enter a filter that describes a page whose query strings you want NetTracker to 

check for this parameter. (In the example earlier, you would enter Check all pages 
that match /image.gif.)

14. Click Add.
15. Click Continue.

You will need to repeat the procedure above for every screen resolution parameter you 
want to track.

Note: If you use image files to pass the screen resolution information to the log file, you 
will need to configure NetTracker to report on the image file. By default, NetTracker does 
not count popular image file types as page views, although the images will still be counted 
as hits. NetTracker will only track parameters for files that are included as valid page 
views.

To track a specific image file
1. View the profile in which you want to track the screen resolution information.
2. Click the Options tab.
3. In the left-hand panel, click Filters and then click Unexcluded Pages.
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4. Click Add.
5. Enter a filter that describes the image file you want to include. (In the example 

earlier, you would enter Do not exclude pages that match /image.gif.)
6. Click Add and then click Continue.

NetTracker is now configured to track screen resolution information for your visitors in all 
new data for this profile.

Errors

40.  NetTracker is complaining that it cannot access certain files.

Some Web servers are very strict when it comes to file permissions. Since part of 
NetTracker runs as a CGI program, the user that your Web server is running as needs to be 
able to read and write the files in NetTracker’s program and HTML directories.

To set NetTracker’s file permissions correctly in UNIX
1. At the command prompt, run umask 022. (This sets the default permissions for all 

new files to rwxr-xr-x.)
2. Reinstall NetTracker.

41.  When I attempt to run NetTracker I get an error message saying unable 
to listen on port 8000. What is wrong?

When you install NetTracker with the No Web Server option, the installation program 
installs a local Web server which runs on port 8000 and only allows connections from the 
local machine. This error message indicates that there is already an application listening 
on port 8000 on the computer on which you installed NetTracker.

To tell NetTracker to listen on another port
1. Open ntweb.cfg in a text editor. (Ntweb.cfg is located in the NetTracker program 

directory. The default NetTracker program directory is C:\Program 
Files\NetTracker on Windows and /usr/local/NetTracker on UNIX.)

2. Change all occurrences of 8000 to some other number (for example, 8001).
3. Save your changes and close the file.
4. Open NetTracker.cfg in a text editor. (NetTracker.cfg is located in the main 

NetTracker program directory.)
5. Change all the URLs to use the new port number.
6. Save your changes and close the file.
7. Open a command prompt.
8. If you are running NetTracker Enterprise or the NetTracker eBusiness Edition, 

type nettracker admin -clear.
9. Regardless of which NetTracker edition you are running, type nettracker all 

-regen.
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42.  NetTracker appears to be stuck, or the server crashed. What do I do?

The first thing to do is to see if NetTracker is still running by looking for the nettracker 
process in the process list. If it is still running, you may want to let it continue.

You can reset NetTracker, but you will lose data in NetTracker Professional or NetTracker 
Enterprise. Resetting NetTracker Professional or NetTracker Enterprise will clear all the 
data from your NetTracker database and you will need to reprocess all of your log files. If 
you are using the NetTracker eBusiness Edition, resetting NetTracker will cause 
NetTracker to roll back to the last successful checkpoint.

To reset NetTracker
1. Open a command prompt and go to the NetTracker program directory. (The 

Windows default is C:\Program Files\NetTracker and the UNIX default is 
/user/local/NetTracker.)

2. Type nettracker reports -abort. (If you are using NetTracker Enterprise 
or the NetTracker eBusiness Edition, substitute your short profile name for reports 
above.)
This will stop NetTracker, reset the Web-browser interface, and give you a chance 
to disable host name and page title resolution if this is the cause of your problem.

If you have a backup of the NetTracker files and you do not want to reprocess your log 
files, you can restore your data. You will then need to run another update to process any 
information in the log files since your last backup. For details on restoring, see question 
13.

43.  I sometimes receive a Document Contains No Data error message when 
I drill down or when I run a custom report. What is wrong?

There are two common causes of this error:

• The permissions on the dynamic directory are incorrect. The dynamic directory 
location is NetTracker HTML directory\profilename\dynamic. The file 
permissions should be set to Full Control for all users. Some programs change the 
file permissions for this directory during installation.

• Your Web server is killing the NetTracker CGI process. The Web server only 
allows a CGI process to run for a limited amount of time. If the process exceeds 
this time, the Web server kills the process. Follow the server-specific instructions 
below to increase the timeout interval.

Apache Web Servers—Increase the time interval specified with the timeout directive in 
httpd.conf and restart the Web server. More details are available at 
http://www.apache.org/docs/mod/core.html#timeout.
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Netscape/iPlanet Web Servers—Documentation on increasing the timeout value can be 
found at http://knowledgebase.iplanet.com/ikb/kb/articles/608.html.

Microsoft IIS 4.0 or 5.x—Increase the timeout value by following the steps below:

1. Open up the Management Console and right-click the Web site that you want to 
configure.

2. Select the Web Site tab.
3. In the Connections box, increase the Connection TimeOut value.

44.  When I try to browse to my log files on a Cobalt RaQ or Qube, I get the 
message Permission Denied. The permissions look fine. What could cause 
this?

Cobalt release a security patch in the fall of 2000 that changed the file permissions for the 
Web server log files and the directory in which they are stored. As a result, the nobody 
user no longer has the correct permissions to read the Web server logs and list the 
directory. Since the Web server (and therefore NetTracker) runs as the nobody user, the 
Browse icon in NetTracker doesn’t work. If you do not know where your log files are 
stored, consult your Cobalt administrator.

You may also notice that the Update icon doesn’t work. This is also a result of the change 
in file permissions. See question 56 for details.

Using Reports in NetTracker

45.  When I print a report, I only see the top part of the Web page or each 
frame prints on a separate page? What am I doing wrong?

In order to print a NetTracker report, you should use the NetTracker Print icon. If you use 
the print button build in to your Web browser, you will have to make the report the active 
window before printing. To do this, click within the report (not the NetTracker panel).

46.  Can our company restrict access to NetTracker to certain departments 
or individuals?

Absolutely. Your Webmaster can limit access to NetTracker to only those who have been 
given a user name and password using your Web server’s built-in password protection. 
Simply contact your Webmaster.

47.  Is there any way to exclude visits from our employees to get an accurate 
analysis of who is visiting our Web site from outside of our company?

Yes. 
25



NetTracker Frequently Asked Questions
To exclude visits from your employees
1. Open the profile in which you want to exclude your employees. (Enterprise and 

eBusiness only)
2. On the main NetTracker panel, click the Options tab.
3. In the left-hand panel, click Filters and then click Excluded Hosts.
4. Click Add.
5. In the drop-down list, select That end with.
6. In the text box, type your company’s host. You must enter the host exactly as it 

appears in the Host Summary.
7. Click Add and then click Continue.

Note: If you want this change to apply to your existing data, you will need to reprocess 
your log files. Before you delete your existing profile data, please make sure you have 
copies of all your processed log files.

48.  Why are all my referrers None and browsers Unknown?

This typically means that either you are currently not logging referrer and browser 
information, or you specified the incorrect log format when you entered your log file. 
Please see the Using Log Files section to find out how to log referrer and browser 
information in your Web server.

49.  I’m using IIS 4.0 or 5.x and when I run NetTracker on my log files I get all 
zeros. What could be causing this?

If you have a log file specified and you are still getting this error, you are probably not 
logging enough information for NetTracker to be able to analyze your log file. You need to 
make sure IIS 4.0 or 5.x is properly configured.

To configure IIS 4.0 or 5.x
1. Open the IIS management console and right-click the Web site whose logging you 

want to configure.
2. Click Properties.
3. Click the Web Site tab and make sure the Enable Logging check box is selected. 

In the Active log format box, select W3C Extended Log File Format.
4. Click Properties.
5. Click the Extended Properties tab.
6. Select the Date and Time fields, and then select all the fields in the Extended 

Properties group.
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50.  Why does it sometimes take up to several minutes for my log file to be 
processed when I click Update?

Depending on the size of your log file, the density of the logs, and the amount of time that 
has lapsed since the last time you or someone else updated the data, it may take a few 
minutes for NetTracker to update your data. Most Webmasters will set their servers to 
automatically run NetTracker every night so the information will be updated regularly. 
Webmasters can find the instructions for this procedure in the answer to question 16.

51.  My reports only cover a specific date range. Log data from outside this 
date range is not being imported. What could cause this?

This is usually caused by a starting date or ending date being set for the profile in the 
Dates option. You need to clear the Dates option, clear the NetTracker database, and 
reprocess your log files.

Note: If you clear your database and you do not have all your original log files you 
imported into NetTracker, you will lose data. Verify that you have all your old log files 
before following these instructions.

To clear the Dates option and the database and reprocess your log files
1. Open the profile whose Dates option you want to change. (Enterprise and 

eBusiness only)
2. On the main NetTracker panel, click the Options tab.
3. In the left-hand panel, click Filters and then click Included Dates.
4. If the Starting date or Ending date check box is selected, clear it.
5. Click Save Options.
6. Click Delete Profile Data.
7. When NetTracker is done clearing the database, click the Update icon.

52.  How do I set up NetTracker to track banner clickthroughs and 
impressions?

In order for NetTracker to track banner ads, you need to redirect all the banner ads that you 
would like to track through a special CGI program that is included with NetTracker. This 
CGI program, named ntadtrack.cgi on UNIX and ntadtrack.exe on Windows, is placed in 
the NetTracker program directory when NetTracker is installed.

To track banner clickthroughs and impressions
1. Copy ntadtrack.cgi or ntadtrack.exe from the NetTracker program directory into a 

CGI-accessible directory (for example, /usr/local/apache/cgi-bin for UNIX or 
C:\inetpub\scripts\ for Windows).

2. Open the profile in which you want to track banner ads. (Enterprise and eBusiness 
only)
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3. On the main NetTracker panel, click the Options tab.
4. In the left-hand panel, click Marketing and then click Banner Ads.
5. In the Full path of ntadtrack.cgi box, (ntadtrack.exe in Windows), enter the path 

to ntadtack.cgi or ntadtrack.exe. This is the path from the document root of your 
Web site, not the path to the file on your computer.
For example, in UNIX, if ntadtrack.cgi is located in /usr/local/apache/cgi-bin/ but 
on your Web site it is accessible as http://yourdomain.com/cgi-bin the full path to 
ntadtrack.cgi would be /cgi-bin/ntadtrack.cgi. Similarly, in Windows, if 
ntadtrack.exe is located in C:\inetpub\scripts\ but on your Web site this directory 
is accessible as http://yourdomain.com/scripts/ then the full path to ntadtrack.exe 
would be /scripts/ntadtrack.exe. In Windows it is important that you allow 
Execute permission on this directory, both for the anonymous Web user using 
NTFS permissions and in the IIS management console.

6. Click Save Options and then click Continue.
7. Click Add.
8. In the Description of banner ad box, enter the name that you want to be used in 

the reports to describe the ad.
9. In the Full path of graphic box, enter the path to this ad. This will be the path 

from the document root of your Web site, not the full path on the system you are 
using. This will be the same path used for the image file in the HTML document 
(for example, XX where img src="XX" is an image file). Example: 
/ads/nettracker.gif.

10. In the URL to link to box, enter the destination that people will reach if they click 
the ad. This must be the exact URL. For instance, if they are going to 
http://www.sane.com/index.html make sure to enter this full path, not just 
http://www.sane.com/.

11. Click Add and then click Continue.
12. Repeat step 7 through step 11 as needed to enter all of the banner ads that you 

want to track.
13. Redirect all of the banner ads through the ntadtrack.cgi (or ntadtrack.exe on 

Windows) program as shown in the example below:
<a href="/cgi-bin/ntadtrack.cgi?http://www.sane.com/products/"><img src=
"/ads/nettracker.gif"></a>
The URL located immediately after the question mark (?) is the URL people will 
go to when they click the banner ad. This URL should exactly match the URL that 
you entered in the URL to link to box.

14. Update your profile. You should now be able to track banner ads through 
NetTracker.

53.  How do I set up NetTracker to track multiple domains when the domain 
all share the same log file?

First you must record the host name in the log file. You will probably need to change your 
log file format in order to do this.
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For Netscape/iPlanet servers, you will need to add the following to your log file format 
string in the obj.conf file:

%Req->headers.host%

For more information about this, you can go to 
http://knowledgebase.iplanet.com/ikb/kb/articles/2397.html.

In early versions of Netscape Web servers, you will have to hand edit the obj.conf file. 
You need to add %Req->headers.host% to the Init format.access line as the second 
field. In later versions of the Netscape Web servers, you should choose Custom Format 
under Log Files in the Netscape Server Administration Web interface and add 
%Req->headers.host% as the second field in the formatting line. For information about 
rotating your logs after making this change, see your Web server documentation. An 
example of a final log format string would be:

%Ses->client.ip% %Req->headers.host% 
%Req->vars.auth-user% [%SYSDATE%] 
"%Req->reqpb.clf-request%" %Req->srvhdrs.clf-status% 
%Req->srvhdrs.content-length% "%Req->headers.referer%" 
"Req->headers.user-agent%"

For Apache, you can add %v to your log file format in the httpd.conf configuration file. 
The %v needs to be the second entry in the log file format. You will have to stop and 
restart the server for this change to take effect. For more information about this, you can 
go to http://www.apache.org/docs-1.2/mod/mod_log_config.html#formats.

Here is a sample log file format which will record virtual hosts in Apache:

LogFormat "%h %v %u %t \"%r\" %>s %b \"%{Referer|i\" 
\"%{User-Agent}i\""

To change NetTracker’s configuration
1. Open the profile for one of the sites you want to track. (Enterprise and eBusiness 

only)
2. On the main NetTracker panel, click the Options tab.
3. Click Main then Advanced and select the Only process traffic to the 

configured site check box.
4. Click Save Options and then click Continue.
5. In the left-hand panel, click Main and make sure the URL of the site being 

analyzed exactly matches the way you are recording the host header in your Web 
log. For instance, if you are recording www.sane.com in the log and you entered 
sane.com in the General Options, the profile will not work correctly.
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After completing these steps, NetTracker should be able to parse out just the hits for the 
site you have specified.

54.  I do not have host name resolution turned on in either my Web server or 
NetTracker and my site is showing up as its own referrer at least 30 percent 
of the time. Is there something wrong?

This problem will occur if a substantial amount of your traffic comes from America 
Online users and you do not have host name resolution turned on in either your Web server 
or in NetTracker.

The way America Online’s proxy servers work, the first request from a user comes from 
one IP address, but the second request may come from a different address, and the third 
request from yet a third address. Because you do not have host name resolution turned on 
in either NetTracker or in your Web server, NetTracker is tracking visitors by IP address. 
For example, an AOL user will come in and make the first request to your site from IP 
1.1.1.1 and your Web server records that along with the information that they were 
referred by Yahoo. They make a request for a second page from IP 2.2.2.2 and their 
referrer will be recorded as the first page they viewed on your site.

Because NetTracker will see 2.2.2.2 as a new visitor (no previous requests from that IP), it 
will record the referrer for that IP as your own site. Because the third and subsequent 
requests from an AOL user are likely to continue to use a large number of proxy server 
IPs, you may get a large number of referrals from your own site very quickly.

There are three solutions to this problem:

• Turn on host name resolution inside your Web server, which will record the host 
names in your log files. Then the requests from America Online users will be 
grouped according to the default Host Groups setting in your NetTracker options 
as America Online, straightening out this referrer problem.

• Turn on host name resolution inside NetTracker—this can be found in the General 
Options of the profile. The requests from America Online users will be grouped 
according to the default Host Groups setting in your NetTracker options as 
America Online, straightening out this referrer problem.

• Use the Host Groups option in NetTracker to enter all of the IP addresses for 
AOL’s proxy servers and clients. There appear to be about fifty. This should 
straighten out the problem without you having to change anything regarding host 
name resolution. To do this, open a NetTracker profile and click the Options tab. 
In the left-hand panel, click Visitors then Host Groups, select America Online, 
click Hosts and click Add. Select that matches and enter one of the IP addresses. 
You will have to do this with each of the fifty IP addresses. You can retrieve the 
list of IP addresses at http://webmaster.info.aol.com/proxyinfo.html. If you are 
using NetTracker Enterprise or the NetTracker eBusiness Edition, you can do this 
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once in the Default Web Server Options and it will apply this host grouping to all 
new profiles. For the profiles you already have set up, you will have to hand enter 
the IP addresses.

55.  When I export to RTF (or CSV) my Web browser displays the document 
in the Web browser screen instead of giving me a Save As dialog.

NetTracker can export data from reports, which allows you to import NetTracker reports 
into popular software products such as Microsoft Excel, Access, and Word. NetTracker 
uses the .csv and .rtf file extensions when exporting data.

Whether you see the document in your Web browser screen or the Save As dialog box 
depends on the MIME settings. You can change the MIME settings for the server where 
NetTracker is hosted so that you always see a Save As dialog box when you export.

However, if you are using Internet Explorer, changing the settings on the NetTracker 
server may not solve the problem for all users. This is because with Internet Explorer, your 
local computer’s MIME settings override the MIME settings on the Web server to which 
you are connecting. If you still have a problem after changing the NetTracker server 
settings, you will need to change your local MIME settings as well.

Changing the MIME Settings for the NetTracker Server

Changing the MIME settings on the server will affect all files that end in .csv and .rtf for 
all users. In order to get the Save As dialog box when you export, you need to set both the 
.csv and .rtf file extensions to application/octet-stream. The procedure varies depending 
on the Web server on which NetTracker is installed.

To set the MIME settings for a Microsoft IIS server
1. Start Windows Explorer.
2. On the View menu, click Options.
3. Click the File Types tab.
4. Click New Type.
5. In the Description of Type box, enter Comma Separated Value.
6. In the Associated Extension box, enter csv.
7. In the Content_Type (MIME) box, enter application/octet-stream.
8. Click OK.
9. If you get a message that the .csv extension is already in use, search through the 

file types to find what is associated with .csv. (If you do not get any error 
messages, you are finished. The MIME settings are now correct.)

10. When you find what is associated with .csv files, select it and click Edit.
11. In the Content_Type (MIME) box, enter application/octet-stream.
12. Click OK.
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13. Repeat step 4 through step 12 for rtf. Use Rich Text Format as the description 
and application/octet-stream as the content type.

To set the MIME settings for a Netscape/iPlanet FastTrack/Enterprise server
1. Change to the directory in which the configuration files are located for the server 

on which you installed NetTracker. (The default path would likely be 
C:\Netscape\server\httpd-servername\config\.)

2. Open mime.types in a text editor.
3. Look for the line

type=application/octet-stream ext=bin
4. Change it to 

type=application/octet-stream ext=bin,csv,rtf
5. Restart the server

To set the MIME settings for an Apache server
1. Change to the <ApacheHome>/conf directory. (UNIX only)
2. Open the file mime.types in a text editor. (In Windows, the default location for 

mime.types is C:\Program Files\Apache Group\Apache\conf.)
3. Look for the line

application/octet-stream bin dms lha lzh exe class
4. Change it to

application/octet-stream bin dms lha lzh exe class csv rtf
5. Save and close mime.types.
6. Restart Apache.

Changing the MIME Settings for Internet Explorer

If you have changed the MIME settings for the server and you still aren’t seeing the Save 
As dialog box, you need to change the MIME settings for Internet Explorer. You will need 
to make the change for CSV, DOC, RTF, and XLS file types.

Note: In order to make the change, you may need to have administrative rights on your 
computer. If you do not have administrative rights, contact your system administrator.

To change your file type properties in Windows 98 and later
1. Click the Start button, point to Settings, and click Control Panel.
2. On the Tools menu, click Folder Options.
3. Click the File Types tab.
4. In the Registered file types box, click CSV and click Advanced. (If you do not 

see the Advanced button, you probably do not have administrative rights. Contact 
your system administrator.)

5. Select the Confirm open after download check box.
6. Click OK.
7. Repeat step 4 though step 6 with DOC, RTF, and XLS.
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8. Click Close.

56.  My Update icon doesn’t work. (I’m using a Cobalt server.) What could 
cause this?

Cobalt released a security patch in the fall of 2000 that changed the file permissions for the 
Web server log files and the directory in which they are located. As a result, the nobody 
user no longer has the correct permissions to read the Web server logs. Because the Web 
server (and therefore NetTracker) runs as the nobody user, when you click the Update 
icon NetTracker does not have the file permissions to read the log files. You can still use 
the -update command-line option to update your NetTracker profiles because when you 
run NetTracker from the command line you are not running as the nobody user. If you 
have NetTracker set up to update nightly, those updates will still work.

You may also notice that the Browse button on the Log Files page does not work. This is 
also the result of the change in file permissions. (See question 44.)

57.  I am using Internet Explorer and I cannot get the graph legend squares 
in the NetTracker summaries to print out in color. All of the squares print out 
empty. What is causing this?

The squares in the legend are generated by creating an HTML table cell and setting the 
background color for the cell. By default, Internet Explorer does not print these 
background colors. You will need to turn on background color printing in Internet 
Explorer.

To turn on background color printing in Internet Explorer
1. Open Internet Explorer.
2. On the Tools menu, click Internet Options.
3. Click the Advanced tab.
4. In the list of options, select the Print background colors and images check box. 
5. Click OK.

Internet Explorer should now print out the page as it is displayed in the browser.

58.  I want to specify page titles to display in the NetTracker reports, but I 
don’t want to tie up my server resolving page titles. How can I do this?

Editing page titles in NetTracker has no effect unless page title resolution is turned on for 
the profile. However, you can work around this issue by turning on page title resolution 
and then configuring the Unresolved Page Titles option so that all page titles are 
unresolved.
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To edit page titles without resolving page titles
1. View the profile in which you want to edit page titles.
2. Click the Options tab.
3. In the left-hand panel, click Page Titles under Content.
4. Specify the page titles that you want to appear in the NetTracker reports. (For 

details, see “Editing Page Titles” in the NetTracker manual.)
5. In the left-hand panel, click General under Main.
6. Turn on page title resolution. (For details, see “Resolving Page Titles” in the 

NetTracker manual.) 
7. In the left-hand panel, click Unresolved Page Titles under Content.
8. Click Add.
9. Enter the filter that contain /
10. Click Add.
11. If you want these changes to take effect in data you import from now on, click 

Continue. If you want these changes to take effect in data you have already 
imported, you will need to delete your profile data and reimport your log files. 
(Note: If you do not still have every log file that you have ever imported into this 
profile, you will lose data by choosing this option.) To delete profile data, click 
Delete Profile Data.
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